
Programski jezik Python



Python

 1970. Niklaus Wirth – Pascal

 1989. Nizozemac Guido van Rossum – Python-naziv 
po grupi Monty Python’s Flying Circus

 Uz proceduralni pristup, objektno usmjereni pristup 
programiranju

 Besplatan

 http://www.python.org/download/

 Python jedan od tri službena programska jezika u 
Google

http://www.python.org/download/


Programsko okruženje za pripremanje programa 
- IDLE

 -Guido van Rossum nazvao IDLE

 Integrated DeveLoment Environment (prezime 
komičara iz grupe Monthy Python – Eric Idle)

 Prozor koji čini interaktivno sučelje s Pythonom

Sučelje Pythona



Python

 Interaktivno sučelje

 Traka izbornika sučelja: File, Edit, Shell, Debug, 
Options, Windows, Help

 Help, IDLE Help pojedine aktivnosti

 Python Docs – upućuje na opsežnu dokumentaciju

 Na početku novog reda >>> znak upita (prompt)

 Sučelje sa znakom upita traži od korisnika odgovor

 Sučelje omogućuje interaktivni rad



Jednostavni tipovi podataka

 Osnovni tipovi podataka: cijeli broj, broj s pomičnom 
točkom, logički ili Booleov tip, znakovni niz ili string

 >>> 120

 120

 Utipkana vrijednost se ispisuje plavom bojom

 Boju ispisa – Options, Configure IDLE



Cijeli brojevi

 Naziv za cjelobrojni tip podataka u Pythonu je int

 U Pythonu nije ograničen broj znamenaka cijelog 
broja



Cijeli brojevi

 Binarni brojevni sustav

 Binarni zapis pretvara u dekadski

 Heksadekadski brojevni sustav



Cijeli brojevi

 Cijeli broj pretvara u binarni

 Cijeli broj pretvara u heksadekadski



Zapisivanje realnih brojeva



Zapisivanje realnih brojeva

Norma IEEE 754

Vrijednosti 5.0  10−324 𝑑𝑜 1.7 10308

Broj koji ima eksponent veći od +308 je 
za Python veliki broj i zapisuje se kao inf
(beskonačno)

Mali broj prikazuje se kao nula

Broj 1.2345678901234567890e-323    u 
Pythonu 0.0



Logički ili Booleov tip podataka

U Pythonu se logički tip naziva bool

Poprima dvije vrijednosti: True i False

True i true nije jednako

 int (True)    1         int (False)   0

bool(1)    True bool(0)    False

bool(100)    True bool(-100)   True



Znakovni niz - string

Osnovni tip podataka za prikaz teksta

 str   - naziv u Pythonu

Vrijednost se obilježava jednostrukim ili 
dvostrukim navodnim znacima na 
početku i kraju niza

Dvostruki navodnik se ne smije pisati 
kao dva uzastopna jednostruka 
navodnika



Posebni znaci za oblikovanje teksta

Posebni znak Opis djelovanja

\n Prijelaz u novi red

\t Tabulator

\\ Ispisati lijevo ukošenu crtu

\’ Ispisati jednostruki navodnik

\’’ Ispisati dvostruki navodnik



Kodovi ASCII i Unicode

 Funkcija ord() , hex(), bin()

UTF-8 kodu kodiranje naših dijakritičkih 
znakova obavlja s dva bajta

Sada su veliko i malo slovo jedno do drugog



Python kao veliki kalkulator – aritmetički izrazi

Operator Opis djelovanja

+ Zbrajanje

- Oduzimanje  ili negacija

* Množenje

** Potenciranje

/ Dijeljenje

// Cjelobrojno dijeljenje

% Računanje ostatka dijeljenja



Python kao veliki kalkulator – aritmetički izrazi



Python kao veliki kalkulator – aritmetički izrazi

 Koliko je dana, sati, minuta i sekundi 1 000 000
sekundi

Operator Značenje simbola

** Potenciranje

- Negacija

*, /,  //,  % Množenje, dijeljenje, ostatak

+, - Zbrajanje, oduzimanje



Primjeri izraza u Pythonu



Primjeri izraza u Pythonu

 Python pamti zadnju izračunatu vrijednost

 Koristimo u sljedećem koraku , pišemo znak _



Varijable i znak pridruživanja

 =     nazivamo znakom pridruživanja

 Ugrađene funkcije: print(), bin(), hex(), int(), 
ord(),…

 abs(-3)      3         abs(2.4)    2.4    abs(-4.7)     4.7



Varijable i znak pridruživanja

 Ugrađena funkcija divmod()





Zadaci za ponavljanje

1. Nabroji osnovne tipove podataka u Pythonu.

2. Dekadni zapis broja 1011 dobit ćemo naredbom:

a. b00001011

b. 0b00001011

c. 00001011b

d. 00001011b0

3. Koje od sljedećih prefiksa trebamo upisati ispred 
heksadekadnog zapisa broja kako bismo dobili 
pripadni dekadni zapis tog broja?

a. x       b. 0     c. 0x     d. x0



Zadaci za ponavljanje

4. Pythonova funkcija koja će vratiti binarni zapis 
dekadnog broja je __________, dok heksadekadni
zapis dekadnog broja vraća funkcija __________.

5. Koji je naziv standarda za zapis realnih brojeva u 
računalu?

6. Naziv logičkog tipa u Pythonu je ___________.

7. Osnovne logičke vrijednosti su: ________ i 
__________.

8. Odredi vrijednosti sljedećih izraza: a. int(False)

b. int(True) c. bool(0) d.bool(5) e. bool(-10) 



Zadaci za ponavljanje

9. Kako nazivamo znakovni tip u Pythonu?

10. Tekst ćemo u Pythonu pisati unutar znakova ___ 
ili ______.

11. Slijedećim posebnim znakovima pridruži pripadne 
opise:

12. Funkcija ord() vraća __________________.

Posebni znak Opis djelovanja

\n Ispisati jednostruki navodnik

\t Prijelaz u novi redak

\’ tabulator



Zadaci za ponavljanje

13. Odredi vrijednost sljedećih izraza:

a. 2 + 7      b. -5 + 2     c. 6/2    d.   10/4   e. 8//4

f. 8//5     g. 9%5    h. 2 + 3*7    i. 3**2 *2

j. 7*3%5      k. 15// 8 %3 + 2 ** 3 % 4

l. 15 % 8 * 3 // 4 * 2 % 6

14. Što će biti ispisano na zaslonu nakon sljedećeg niza 
naredbi napisanih u Pythonu?

2 + 3

_ -1

_*4

_/7            



Zadaci za ponavljanje

15. Odredi vrijednost varijable t nakon izvođenja 
sljedećeg niza naredbi ako je vrijednost varijable t 
postavljena na 10 ( t = 10) ?

r = 2 *t

t= r % 7

t = r + t

16. Koja će biti vrijednost varijable k nakon sljedećeg 
niza naredbi?

a, b = divmod(48, 10)

k = a + b



Priprema i izvođenje programa

Interaktivni i uređivački dio sučelja IDLE
 Programi u Pythonu, novi prozor – uređivački dio sučelja 

IDLE, otvaramo ga da u interaktivnom sučelju (Python
Shell), File -> New Window ili (Ctrl) + (N)

 Izgled prozora

Uređivački dio sučelja IDLE

 U traci izbornika nalaze se nazivi padajućih izbornika: File, 
Edit, Format, Run, Options, Windows i Help.



Priprema i izvođenje programa

 Help -> IDLE Help – opis funkcija pojedinih naredbi.

 File -> Save as pohranjujemo napisani program.

 Naziv programa te iza njega sufiks   .py

 Modul – datoteka koja ima sufiks

 Open – otvaramo program

 Program se pokreće  Run i naredbom Run Module ili F5

Prozor pohranjenog programa primjer_1



Priprema i izvođenje programa

 # označivanje komentara

 Nakon pokretanja programa

Ispis programa   

 Funkcija print() služi za ispisivanje sadržaja na zaslon 
monitora.



Priprema i izvođenje programa

 input() - za unošenje sadržaja 

sep=’’, između ispisanih sadržaja neće biti razmaka



Formatirani ispis

 print(‘st_1{br_1}st_2{br_2},…,st_n{br_n}’.format(v_1,v_2,…,v_n))

pri ćemu vrijedi:
 st_1, st_2,…, st_n   - proizvoljni tekst,
 v_1, v_2, … , v_n   - popis varijabli koje želimo ispisati,
 br_1, br_2, …, br_n - predstavlja redne brojeve varijabli 

unutar popisa.



Formatirani ispis

 d – ako ispisujemo cijeli broj,
 f – ako ispisujemo realni broj,
 s – ako ispisujemo string.
 Ispis cijelih brojeva moguće je formatirati naredbom:

{nd}, n neki prirodni broj ili 0, označava broj na koliko će se 
mjesta ispisati određeni prirodni broj.
 {n.mf} , n ukupni broj mjesta na koji će se realni broj 

ispisati (uključujući i decimalnu točku), m – broj znamenki 
iza decimalne točke koje će biti ispisane.



Formatirani ispis

Izgled formatiranog ispisa prilikom unosa podataka:



Osnovna pravila pisanja programa

 Pravila za pisanje imena:
- Imena se sastoje od proizvoljnog broja slova, znamenki i 

podvlaka, ne smiju početi znamenkom.
- Python razlikuje velika i mala slova, a i A različita imena

Ključne riječi: 
False class finally is               return
None    continue for            lambda try
True def              from nonlocal while
and del global      not with
as           elif if or yield
assert else import    pass
break except in raise



Naredbe višestrukog pridruživanja

varijabla_1, varijabla_2, … = izraz_1, izraz_2, …



Program za preračunavanje sekundi u dane, sate i 
minute



Jednostavniji zapis

sekunde=input(‘Upisati broj sekundi: ‘)

sekunde= int(sekunde)

Jednostavnije pisanje:

sekunde=int(input(‘Upisati broj sekundi: ‘))

File -> Recent Files , aktivira pomoćni padajući 
izbornik s nizom programa, odnosno modula koje 
smo u posljednje vrijeme upotrebljavali



Zadaci za vježbu

1. Napiši program koji će unositi duljine stranica 

pravokutnika i ispisivati:

a) opseg pravokutnika

Primjer: 

b) površina pravokutnika

Primjer:

Unos Ispis

2 14

5

Unos Ispis

2 10

5



Zadaci za vježbu

2. Napiši program koji će unositi prirodan broj n i 
ispisivati površinu kvadrata čija  stranica ima duljinu n.

Primjer:

3. Napiši program koji će unositi ocjene iz pet predmeta, a 
ispisivati prosjek ocjena.

Unos Ispis

6 36

Unos Ispis

3 4.2

4

5

4

5



Zadaci za vježbu

4. Ivana već dugo želi kupiti novu pernicu koja stoji n 
kuna. Za rođendan je od bake dobila m kuna (m<n). 
Nakon što je djedu ispričala priču s pernicom, djed joj je 
obećao da će joj dati ostatak novaca. Kako još ne zna 
najbolje računati, moli te za pomoć. Napiši program koji 
će unositi cijenu pernice (n) i iznos koji je dobila od 
bake (m), a ispisivati iznos koji joj treba dati djed kako 
bi mogla kupiti pernicu.

Primjer: Unos Ispis

132 82

50



Zadaci za vježbu

5. Napiši program koji će unositi dva prirodna broja a i 
b te ispisivati njihov zbroj, razliku, umnožak i količnik 
(drugi je broj uvijek različit od nule). Ispis programa 
treba biti „punog” oblika, primjerice, za unos brojeva 5 i 
7 te operaciju + ispis treba biti 5 + 7 = 12.

Primjer:
Unos Ispis

4 4+2=6

2 4-2=2

4*2=8

4/2=2.0



Zadaci za vježbu

6. Napiši program koji će unositi iznos odobrenog 
potrošačkog kredita c, godišnju kamatnu stopu p, broj 
mjeseci m, a ispisivati kamate prema formuli:

Primjer:

Unos Ispis

1000 43.33

8

12

 
2400

1


mcp
k



Zadaci za vježbu

7. Ivica ima n kuna za koje želi kupiti prijateljicama 
čokolade. Jedna čokolada stoji m kuna. Ivicu zanima 
koliko će najviše čokolada moći kupiti te koliko će mu 
novca nakon toga još preostati. Pomogni Ivici i napiši 
program koji će unositi iznos novca kojim Ivica 
raspolaže te cijenu jedne čokolade, a ispisivati koliko 
maksimalno čokolada Ivica može kupiti te koliko će mu 
novca nakon toga preostati. 

Primjer: Unos Ispis

100 5

17 15



Moduli – zbirke funkcija

 import – f unkcije iz modula koje želimo upotrijebiti 
moramo najprije najaviti 

 u interaktivnom prozoru

>>> x=16
>>> import math
>>>y=math.sqrt(x)
>>> y
4.0

>>> from math import sqrt
>>> x=25
>>> y=sqrt(x)
>>> y
5.0
>>> print(sqrt(81))
9.0



Moduli – zbirke funkcija

 Uvoz funkcija može se obaviti tako da se umjesto 
imena funkcije stavi znak *. Znak * simbolizira sve 
funkcije koje se nalaze u modulu.

>>> from math import *

>>> print(sqrt(2))

1.4142135623730951

>>> x=3

>>> y=4

>>> print(sqrt(x**2 + y**2))

5.0



Moduli – zbirke funkcija

>>> r=1

>>> from math import pi

>>> print('Površina kruga s polumjerom {0} iznosi {1}'.format(r,pi*r**2))

Površina kruga s polumjerom 1 iznosi 3.141592653589793

Preporuka za uvoz modula koristiti se naredbom:

 import ime_modula  ili 

 from ime_modula import ime_funkcije_1, ime_funkcije_2,...

 Najčešće korištene funkcije modula math su: ceil(x), 
floor(x),exp(x), log(x,b), sin(x), cos(x), tan(x), asin(x), acos(x).



Moduli – zbirke funkcija

Funkcija Opis Primjer

ceil(x) Najmanji cijeli broj veći 
od ili jednak x

ceil(3.4)=4
ceil(4.9)=5

floor(x) najveći cijeli broj manji 
ili jednak x

floor(3.2) = 3
floor(7.8)=7

exp(x) exp(1)=2.71828

log(x,b) log(100,10)=2.0

sin(x) sin x sin(pi)= 0

cos(x) cos x cos(pi)= -1

tan(x) tg x tan(0)=0.0

asin(x) Arcus sinus asin(-1)= 1.57079

acos(x) Arcus kosinus acos(-1)=3.14159

xe

xblog



Moduli – zbirke funkcija

 Unutar modula math ne nalaze se funkcije:

abs(x), round(x), one su ugrađene funkcije u Pythonu

 Funkcija round(x) vraća cijeli broj koji je najbliži realnom 
broju x

 round(7.2)=7,    round(9.8)=10,    round(-3.2)= -3

 Modul random sadržava funkcije kojima se može generirati 
nasumične brojeve i modelirati slučajne događaje i pojave.

 U modulu random postoji funkcija randint(a,b)



Moduli – zbirke funkcija

>>> from random import randint

>>> print(randint(0,1))

1

>>> print(randint(5,15))

12

>>> print(randint(25,150))

114



Uvjetne naredbe

if,  if – else,  if – elif – else

Opći oblik naredbe grananja :

if uvjet_1:

naredba_1

elif uvjet_2:

naredba_2

...

elif  uvjet_n:

naredba_n

else:

naredba



Uvjetne naredbe

if...else

x,y=17,25

print('Koliki je zbroj brojeva {0} i {1}?'.format(x,y))

z=int(input('Utipkati odgovor: '))

if z == x+y:

print('Točno!')

else:

print('Netočno!')



Uvjetne naredbe

if...else

x,y=17,25

print('Koliki je zbroj brojeva {0} i {1}?'.format(x,y))

z=int(input('Utipkati odgovor: '))

if z == x+y:

print('Točno!')

else:

print('Netočno!')



Uvjetne naredbe

import random
a,b=1,9
x,y=random.randint(a,b), random.randint(a,b)
operator = random.randint(0,1)
if operator:

oper='umnožak'
t=x*y

else:
oper='zbroj'
t=x+y

print('Koliki je {0} brojeva {1} i {2}?'.format(oper,x,y))
z=int(input('Utipkati odgovor: '))
if z == t:

print('Točno!')

else:
print('Netočno!')



Uvjetne naredbe

Primjer 1.

Napiši program koji će od zadana tri broja ispisati najveći od njih.

#program if_primjer_1

from math import*

a=int(input("a = "))

b=int (input("b = "))

c=int (input("c = "))

max = a

if (b>max):

max=b

if(c>max):

max=c

print('Max= {0:d}'.format(max))



Relacijski operatori

Relacijski operatori

Operator Značenje simbola

> veće od

< manje od

>= veće od ili jednako

<= manje od ili jednako

== jednako

!= nije jednako



Logički operatori

Logički operatori

Redosljed izvođenja logičkih operacija

Operator Naziv operacije Algebarski simbol

and I operacija, konjunkcija ^

or ILI operacija, disjunkcija 

not NE operacija, 
komplementiranje



Redosljed Operacija

1. not

2. and

3. or



Redoslijed izvođenja operacija

Redosljed izvođenja  operacija

>>> 2+3<4
False
>>> 2*3 -11>3*3 -5
False
>>> 3+4>5 and 3+5 >4 and 4 + 5 >3
True
>>> False or not False
True
>>> False and True
False
>>> 

Redosljed Operacija

1. aritmetički

2. relacijski

3. logički



Donošenje odluka u programima

Primjer 2.

Zadaj prirodni broj. Ispiši je li taj broj djeljiv sa sedam.

# djeljivost broja sa 7

print('Program će ispisati je li neki utipkani broj djeljiv sa 7')

broj=int(input('Utipkati prirodni broj: '))

if broj % 7  ==0:

print('Broj {} je djeljiv sa sedam.'.format(broj))

else:

print('Broj {} nije djeljiv sa sedam.'.format(broj))



Za uneseni broj želimo ustanoviti je li manji od nule, jednak 
nuli ili je veći od nje.

# Izbor jedne od tri mogućnosti s if-else strukturom

broj=int(input('Utipkati željeni broj:'))

if broj== 0:

print('Broj je jednak nuli.')

else:

if broj>0:

print('Broj je veći od nule.')

else:

print('Broj je manji od nule.')



Za uneseni broj želimo ustanoviti je li manji od nule, jednak 
nuli ili je veći od nje, upotreba elif

# Izbor jedne od tri mogućnosti s if-elif-else strukturom

broj=int(input('Utipkati željeni broj:'))

if broj== 0:

print('Broj je jednak nuli.')

elif broj>0:

print('Broj je veći od nule.')

else:

print('Broj je manji od nule.')



Kiselost i lužnatost otopina izražavaju se pH-
vrijednostima. 

Napiši program koji će za utipkanu pH – vrijednost napisati 

kakva je otopina.

pH Opis

<0,4.5] jako kisela

<4.5,6.5] slabo kisela

<6.5,7.5] neutralna

<7.5,9.5] slabo lužnata

<9.5,14] jako lužnata



Kiselost i lužnatost otopina izražavaju se pH-
vrijednostima. 

# Klasifikacija otopina po pH- vrijednostima

print('Program će ovisno o utipkanoj vrijednosti napisati je li otopina jako 
kisela, slabo kisela, neutralna, slabo lužnata ili jako lužnata')

ph=float(input('Upisati pH-vrijednost: '))

if ph>0 and ph <=4.5:

print('Otopina s pH-vrijednošću {0:0.1f} je jako kisela.'.format(ph))

elif ph>4.5 and ph <=6.5:

print('Otopina s pH-vrijednošću {0:0.1f} je slabo kisela.'.format(ph))

elif ph>6.5 and ph <=7.5:

print('Otopina s pH-vrijednošću {0:0.1f} je neutralna.'.format(ph))

elif ph>7.5 and ph <=9.5:

print('Otopina s pH-vrijednošću {0:0.1f} je slabo lužnata.'.format(ph))

elif ph>9.5 and ph <=14.0:

print('Otopina s pH-vrijednošću {0:0.1f} je jako lužnata.'.format(ph))

else:

print('Zadana vrijednost  pH ={0:0.1f} nije uobičajena.'.format(ph))



Ponavljanje bčpkova naredbi 

for i  in range(n):

blok_naredbi

...

ponavlja se od 0 do n-1

>>> for i in range(5):

print(i)

0

1

2

3

4



Ponavljanje bčpkova naredbi 

>>> for i in range(5):

print(i, end=' ')

0 1 2 3 4 

>>> for i in range(100):
print(i,end=' ')
if not((i+1) % 10):

print()

0 1 2 3 4 5 6 7 8 9 
10 11 12 13 14 15 16 17 18 19 
20 21 22 23 24 25 26 27 28 29 
30 31 32 33 34 35 36 37 38 39 
40 41 42 43 44 45 46 47 48 49 
50 51 52 53 54 55 56 57 58 59 
60 61 62 63 64 65 66 67 68 69 
70 71 72 73 74 75 76 77 78 79 
80 81 82 83 84 85 86 87 88 89 
90 91 92 93 94 95 96 97 98 99 



Ponavljanje bčpkova naredbi 

>>> for i in range(100):
print('{:3d}'.format(i),end=' ')
if not((i+1) % 10):

print()

0   1   2   3   4   5   6   7   8   9 
10  11  12  13  14  15  16  17  18  19 
20  21  22  23  24  25  26  27  28  29 
30  31  32  33  34  35  36  37  38  39 
40  41  42  43  44  45  46  47  48  49 
50  51  52  53  54  55  56  57  58  59 
60  61  62  63  64  65  66  67  68  69 
70  71  72  73  74  75  76  77  78  79 
80  81  82  83  84  85  86  87  88  89 
90  91  92  93  94  95  96  97  98  99 



Napiši program koji će unositi prirodan broj n i 
ispisivati sve njegove djelitelje.

# Ispis svih djelitelja broja n
n= int(input('Unesi prirodni broj: '))
for i in range(1,n+1):

if n % i = 0:
print(i,end=' ')

Unesi prirodni broj: 15
1 3 5 15 

Funkcija range(). Može se pozvati i s tri parametra:

>>>for i in range(1,10,3)
print(i)

1
4
7
>>>



Range

>>>for i in range(1,10,3)

print(i)

1

4

7

>>>for i in range(10,4,-2):

print (i)

10

8

6



Range

>>>for i in range(10,12,-1)

print(i)

prvi parametar funkcije 

range() je manji od drugog,

pa nema nikakvog ispisa



Napiši program koji će unositi prirodni broj n i 
provjeravati je li prost broj 

# Provjerava je li učitani broj prost

n = int(input('Unesi broj: '))

brojac= 0

for i in range(1,n+1):

if n% i == 0:

brojac+=1

if brojac ==2 and n>1:

print('Broj {} je prost'.format(n))

else:

print('Broj {} nije prost'.format(n))

Unesi broj: 17

Broj 17 je prost

Unesi broj: 15

Broj 15 nije prost

Prosti brojevi:  2,3,5,7,11,13,...  Ako broj nije prost, za njega ćemo 

reći da je složen. Broj 1 nije niti prost niti složen.



Uvjetno ponavljanje bloka naredbi

. . .

while uvjet:

blok_naredbi

. . .

while i<10:

print(i,end=‘ ‘)

i+=1

0  1  2  3  4  5  6  7  8  9



Uvjetno ponavljanje bloka naredbi

# Srednja visina uz korištenje while petlje

print('Izračunavanje srednje visine proizvoljnog broja osoba')

n=0

s=0

ima_brojeva='da'

while ima_brojeva =='da':

v=float(input('Upisati visinu u m: '))

s +=v

n +=1

ima_brojeva=input('Ima li još unosa (utipkati da ili ne)? ')

print('\n Srednja visina {} osoba u metrima je {:.4f}'.format(n,s/n))    



Uvjetno ponavljanje bloka naredbi

Izračunavanje srednje visine proizvoljnog broja osoba

Upisati visinu u m: 1.78

Ima li još unosa (utipkati da ili ne)? da

Upisati visinu u m: 1.56

Ima li još unosa (utipkati da ili ne)? da

Upisati visinu u m: 1.83

Ima li još unosa (utipkati da ili ne)? da

Upisati visinu u m: 1.72

Ima li još unosa (utipkati da ili ne)? da

Upisati visinu u m: 1.65

Ima li još unosa (utipkati da ili ne)? da

Upisati visinu u m: 1.69

Ima li još unosa (utipkati da ili ne)? ne

Srednja visina 6 osoba u metrima je 1.7050



Uvjetno ponavljanje bloka naredbi

# Srednja visina uz korištenje while petlje

print('Izračunavanje srednje visine proizvoljnog broja osoba')

n=0

s=0

v=float(input('Upisati visinu u metrima (negativni broj za kraj: '))

while v > 0:

s +=v

n +=1

v=float(input('Upisati visinu u metrima (negativni broj za kraj): '))

print('\n Srednja visina {} osoba u metrima je {:.4f}'.format(n,s/n)) 



Uvjetno ponavljanje bloka naredbi

Izračunavanje srednje visine proizvoljnog broja osoba

Upisati visinu u metrima (negativni broj za kraj: 1.78

Upisati visinu u metrima (negativni broj za kraj): 1.56

Upisati visinu u metrima (negativni broj za kraj): 1.83

Upisati visinu u metrima (negativni broj za kraj): 1.72

Upisati visinu u metrima (negativni broj za kraj): 1.65

Upisati visinu u metrima (negativni broj za kraj): 1.69

Upisati visinu u metrima (negativni broj za kraj): -1

Srednja visina 6 osoba u metrima je 1.7050



Ugrađene funkcije

Upoznali smo funkcije: int(), float(), bin(), hex(), ord(), input(), print(), 

abs(), round()

Ugrađene funkcije:

(kolicnik,ostatak)= divmod(a,b)     

Funkcija Primjer

min(a,b,c,...) min(2,1,5)=1

max(a,b,c,...) max(2,1,5)=5

pow(a,b) pow(2,5)=32

pow(a,b,n) pow(2,5,3)=2



Ugrađene funkcije

import math

help(math) – ispisati popis svih funkcija i ostalih podataka o 

modulu, slijedi dio ispisa:

FUNCTIONS

acos(...),   acos(x)

Return the arc cosine (measured in radians) of x.

acosh(...), acosh(x)

Return the hyperbolic arc cosine (measured in radians) of x.

asin(...), asin(x)

Return the arc sine (measured in radians) of x.

asinh(...), asinh(x)

Return the hyperbolic arc sine (measured in radians) of x.



Definiranje vlastitih  funkcija

def ime_funkcije(popis_parametara):

blok_naredbi

return vrijednost

Primjer 1: Napiši funkciju koja za zadani prirodni broj 

provjerava je li broj paran te ispisuje odgovarajuću poruku.

#program 1

def paran(n):

if n%2==0:

print('Broj {0} je paran'.format(n))

else:

print('Broj {0} je neparan'.format(n))

return

n=int(input("unesi broj n:"))

paran(n)



Definiranje vlastitih  funkcija

Definiraj više brojeva i za njih provjeri jesu li parni:

#program 2
def paran(n):

if n%2==0:
print('Broj {0} je paran'.format(n))

else:
print('Broj {0} je neparan'.format(n))

return

n=int(input("Koliko brojeva:"))
for i in range(n):

a=int(input("Zadaj broj:"))
paran(a) 

Koliko brojeva:5
Zadaj broj:3
Broj 3 je neparan
Zadaj broj:6
Broj 6 je paran
Zadaj broj:2
Broj 2 je paran
Zadaj broj:7
Broj 7 je neparan
Zadaj broj:99
Broj 99 je neparan



Definiranje vlastitih  funkcija

def armstrongov(n):
#funkcija  True ako je n Armstrongov broj, a inače vraća False

s=0
t=n
while n>0:

s+=(n%10)**3
n//=10

if s==t:
return True

else:
return False

for i in range (1,501):
if armstrongov(i):

print(i)

1
153
370
371
407



Definiranje vlastitih  funkcija

def armstrongov(n):
#funkcija vraća True ako je n Armstrongov broj, a inače vraća 
False

s=0
t=n
while n>0:

s+=(n%10)**3
n//=10

if s==t:
return True

else:
return False

def main():
for i in range (1,501):

if armstrongov(i):
print(i)

return

1
153
370
371
407



Definiranje vlastitih  funkcija

def armstrongov(n):

#funkcija True ako je n Armstrongov broj, a inače vraća False

s=0

t=n

while n>0:

s+=(n%10)**3

n//=10

if s==t:

return True

else:

return False

def main():

for i in range (1,501):

if armstrongov(i):

print(i)

return

main()

1
153
370
371
407



Definiranje vlastitih  funkcija

def armstrongov(n):

#funkcija True ako je n Armstrongov broj

s=0

t=n

while n>0:

s+=(n%10)**3

n//=10

if s==t:

return True

else:

return False

def prost(n):

for i in range(2,round(n**(1/2)+1)):

if n%i==0:

return False

if n>1:

return True

else:

return False

def main():

n=int(input('Unesi prirodan broj: 

'))

b=0

for i in range (1,n+1):

if armstrongov(i)and prost(i):

b+=1 

print(i)

if b==0:

print('Nema')

return

main()



Razni zadaci s funkcijama:

1. Napiši program koji će izračunati tangens kuta zadanog u 

stupnjevima, minutama i sekundama, uz pomoć funkcije.

2. Napiši program koji će za zadana dva kompleksna broja 

ispisati njihov zbroj i umnožak. 

3. Napiši program koji će za zadane stranice i dijagonalu 

pravokutnika izračunati drugu stranicu, opseg i površinu. 

4. Napišite program koji će izračunati i ispisati imaginarni dio 

umnoška dva kompleksna broja. 

5. Napišite program koji će ispisati zbroj i umnožak znamenki 

učitanog prirodnog broja. 

6. Napišite program koji će od tri zadana realna broja ispisati 

njihovu aritmetičku i harmonijsku sredinu.



Razni zadaci s funkcijama:

7. Napiši program koji će ispisati opseg i površinu kvadrata ako 

je poznata duljina njegove dijagonale. 

8. Napiši program koji će uz pomoć funkcije ispisati najmanji 

od triju zadanih cijelih brojeva.

9. Napiši program koji će na odsječku [200,400] ispisati zbroj 

brojeva, broj brojeva djeljivih sa sedam i koliko ih je neparnih. 

10. Napišite program koji će ispisati zbroj brojeva djeljivih sa 

13 na odsječku [200, 400].

11. Napišite program uz pomoć funkcije koji će za učitani 

realni broj ispisati njegov cijeli i decimalni dio.

12. Napišite funkciju čiji će ulazni parametri biti dva prirodna 

broja. Funkcija treba vraćati zbroj tih dvaju brojeva.



Rješenja nekih zadataka:

Napišite funkciju čiji će ulazni parametri biti dva prirodna broja. Funkcija 

treba vraćati zbroj tih dvaju brojeva.

#program 12
def zbroj(a,b):

x=a+b
return x

def main():
a=int(input("Prvi broj:"))
b=int(input("Drugi broj:"))
print('Zbroj brojeva {} i {} iznosi {}'.format(a,b,zbroj(a,b)))

main()



Rješenje prvog zadataka

Napiši program koji će izračunati tangens kuta zadanog u stupnjevima, minutama i sekundama, uz pomoć 

funkcije.

#program 1a

from math import *
def tg(stu,min,sek):

kut=stu+min/60+sek/3600

rad=kut*pi/180
x=sin(rad)/cos(rad)
return x

def main():
stu=int(input("Zadaj stupnjeve:"))
min=int(input("Zadaj minute:"))

sek=int(input("Zadaj sekunde:"))
print('Za zadani kut {0} stu {1} min i {2} sek tangens iznosi: {3:.2f}'.format(stu,min,sek,tg(stu,min,sek)))

main()



Rješenje trećeg zadataka

#program 3
from math import *
def b(a,d):

x=sqrt(pow(d,2)-pow(a,2))
return x

def o(a,d):
y=2*(a+b(a,d))
return y

def p(a,d):
z=a*b(a,d)
return z

def main():
a=int(input("Zadaj stanicu a=:"))
d=int(input("Zadaj dijagonalu d=:"))
print('Za zadanu stranicu a = {0} i dijagonalu d = {1}, stranica b = {2: 

.2f},  opseg = {3: .2f}, povrsina = {4: .2f} 
'.format(a,d,b(a,d),o(a,d),p(a,d)))

return
main()


